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iColor Keypad 
Set LED light shows and scenes at the touch of a button

•	 Eight	onboard	effects	and	eight	configurable	
scenes	—	iColor	Keypad	uses	onboard	lighting	
effects,	eliminating	the	need	for	an	external	data	
source.	Use	the	iColor	Keypad	Effect	Manager	
configuration	software	to	select	from	eight	effects	
and	adjust	effect	settings	such	as	color,	speed,	and	
brightness	as	desired.	Store	up	to	eight	sets	of	
effects	and	settings	as	scenes.	Recall	scenes	at	the	
touch	of	a	button.	

•	 Enhanced	color	picker	—	iColor	Keypad	Effect	
Manager	configuration	software	offers	improved	
ability	to	define	colors	using	the	RGB	or	HSV	
color	models,	as	well	as	the	ability	to	select	
shades	of	white	and	tinted	whites	around	the	
black-body	curve.

•	 Power	over	Ethernet	for	increased	flexibility	
—	The	IEEE	802.3af	standard	for	Power	over	
Ethernet	(PoE)	enables	both	electrical	power	and	
data	to	be	transmitted	over	a	single	twisted-pair	
cable.	Shared	cabling	reduces	installation	costs,	
decreases	the	space	required	for	wires,	and	
affords	freedom	of	placement	by	eliminating	wiring	
to	a	power	source.	iColor	Keypad	works	with	any	
PoE-compliant	switch	or	PoE	injector.

•	 Fingertip	dimming	and	on	/	off	control	—	Easily	
adjust	brightness	of	connected	lights	from	0%	–	
100%,	or	turn	them	on	and	off.

•	 Simple	installation	with	a	single	Ethernet	
connection	—		Mounts	in	a	standard	U.S.	single-
gang	wall	box.	Uses	a	single	CAT	5e	or	better	
cable	for	data	and	power	with	no	additional	wiring	
required.

•	 Compact	design	with	sleek	Decora	faceplate	—	
Compact	design	uses	wall	space	efficiently.	Decora	
faceplate	hides	mounting	hardware	for	a	clean	
look	that	blends	with	a	variety	of	architectural	
styles.

iColor	Keypad	is	a	compact	stand-alone	lighting	controller	for	intelligent	RGB	and	intelligent	white-light	LED	
lighting	fixtures	from	Philips	Color	Kinetics.	This	Ethernet-based	wall-mounted	controller	triggers	up	to	
eight	light	shows	at	the	touch	of	a	button.	Power	over	Ethernet	(PoE)	technology	eliminates	the	need	for	a	
separate	power	source,	affording	greater	freedom	of	placement,	higher	reliability,	and	easy	installation.

FPO

Controls a Full  
DMX Universe
iColor	Keypad	controls	
one	DMX	universe	of	
512	DMX	channels.
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The Power of Power over Ethernet
The	IEEE	802.3af	standard	for	Power	over	Ethernet	(PoE)	enables	both	electrical	
power	and	data	to	be	transmitted	over	a	single	twisted-pair	cable.	iColor	Keypad	is	a	
PoE-compliant	powered	device	that	offers	you	convenience,	increased	flexibility,	and	
simplified	and	inexpensive	installation,	

A New Standard of Flexibility 
You	can	use	iColor	Keypad	two	ways:	with	a	PoE-compliant	Ethernet	switch,	or	with	
a	standard	Ethernet	switch	and	PoE	injector.	Regardless	of	which	method	you	use,	
you	can	position	each	iColor	Keypad	up	to	328	ft	(100	m)	from	the	switch.	Since	
power	is	delivered	over	the	same	wire	as	the	data,	you	do	not	need	to	use	additional	
wiring	or	position	the	keypad	near	an	external	power	source.

If	you’re	using	a	PoE	switch,	you	simply	connect	iColor	Keypad	to	an	available	port	on	
the	switch	using	a	standard	Ethernet	cable.	If	you’re	using	a	non-PoE	switch,	you	must	
also	attach	a	PoE	injector	to	the	Ethernet	cable,	You	can	position	the	PoE	injector	
near	the	switch	to	keep	the	power	and	data	sources	together	in	the	same	location,	
and	to	give	you	maximum	flexibility	in	positioning	the	keypad	in	a	convenient	location.

Power
Supply

Power
Sourcing 

Equipment
(POE Switch)
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Device

(Keypad)
Ethernet Cable
(Power / Data)
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iColor	Keypad	buttons,	showing	factory	settings

Variable  Color



iColor Keypad  Product Guide4

Specifications
Due	to	continuous	improvements	and	innovations,	specifications	may	change	without	notice.

4.7 in
(119 mm)

2.9 in
(74 mm)

1.31 in
(33 mm)

0.29 in
(7 mm)

1.8 in
(46 mm)

Item Specification Details

Control Ethernet
Minimum	10BASE-T	from	any	PoE-	or	IEEE	802.3af-compliant	
Ethernet	switch.	PoE	injector	required	for	use	with	non-IEEE	
802.3af-compliant	switches

Physical

Dimensions	
(Height x Width x Depth)

4.7	x	2.9	x	1.31	in	 (119	x	74	x	33	mm)

Weight 4.23	oz	 (120	g)

Housing Medium	matte	white	plastic	Decora-style	faceplate	
Mounts	in	single-gang	wall	box

Connector	/	Cable RJ45	Port,	CAT	5e	or	better	data	cable	(not	included)

Operating	Temperature 14°	–	104°	F	 (-10°	–	40°	C)

Humidity 0	–	95%,	non-condensing

Certification	
and	Safety

Certification CSA,	FCC	Class	B,	CE,	CQC

Environment Indoor	rated,	IP20
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Keypad and Accessories
iColor	Keypad	is	part	of	a	complete	system	that	includes:

•	 A	PoE-compliant	switch	to	supply	data	and	power	to	the	keypad,	or	a	non-PoE	
switch	with	one	PoE-compliant	power	injector	per	keypad

•	 CAT	5e	or	better	data	cable	to	connect	the	keypad	to	switch	or	PoE	injector

	Use	Item	Number	when	ordering	in	North	America.

POE

IEEE 802.3af COMPLIANT

ETHERNET SWITCH

(PoE Port)

ETHERNET SWITCH

IEEE 802.3af

COMPLIANT

SINGLE PORT

INJECTOR

IN

OUT

< 328 ft (100 m)

Ethernet Controller KeypadDesigned in the USA, Made in China.

Ethernet Controller KeypadDesigned in the USA, Made in China.

< 328 ft (100 m)

POE

IEEE 802.3af COMPLIANT

ETHERNET SWITCH

(PoE Port)

ETHERNET SWITCH

IEEE 802.3af

COMPLIANT

SINGLE PORT

INJECTOR

IN

OUT

< 328 ft (100 m)

Ethernet Controller KeypadDesigned in the USA, Made in China.

Ethernet Controller KeypadDesigned in the USA, Made in China.

< 328 ft (100 m)

Connect to IEEE 802.3af  
compliant PoE switch or 
PoE Injector and Ethernet switch
For	detailed	wiring	diagrams	visit	
www.colorkinetics.com/support/wiring/
ls_prod.html	

Item Item	Number Philips	12NC

iColor	Keypad 103-000028-00 910503702320

Power	over	Ethernet	Switch 4	Power	over	Ethernet	ports,		
8	ports	total 120-000084-01 910503702557

Power	over	Ethernet	Injector
North	America	Power	Cord 109-000029-00 910503700383

Europe	Power	Cord 109-000029-01 910503700384

Included	in	the	box
iColor	Keypad
Software	CD
Standard	single-gang	wall	box	for	use	outside	of	
North	America

(2)	self-threading	flat	head	countersunk	M2.5	screws

Decora-style	faceplate

Installation	Instructions
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Installation
iColor	Keypad	can	be	installed	in	any	Ethernet	lighting	installation	using	Data	Enabler	
Pro	devices	or	power	/	data	supplies	that	support	KiNET,	the	Ethernet	lighting	
protocol	from	Philips	Color	Kinetics.	Each	iColor	Keypad	button	broadcasts	a	stored,	
configurable	scene	to	all	LED	lighting	fixtures	in	your	installation.	

iColor	Keypad	requires	data	and	power	over	a	single	Ethernet	connection.	A	PoE-
compliant	Ethernet	switch	delivers	both	data	and	power	over	a	standard	CAT	5e	or	
better	data	cable.	Installations	with	non-PoE	switches	require	a	PoE-compliant	power	
source,	such	as	the	PoE	Injector.	

Owner/User Responsibilities
It	is	the	responsibility	of	the	contractor,	installer,	purchaser,	owner,	and	user	to	install,	
maintain,	and	operate	iColor	Keypad	in	such	a	manner	as	to	comply	with	all	applicable	
codes,	state	and	local	laws,	ordinances,	and	regulations.	Consult	with	the	appropriate	
electrical	inspector	to	ensure	compliance.

Prepare the Installation
The	positioning	of	iColor	Keypad	is	generally	determined	by	the	installation	
configuration,	especially	the	locations	of	fixtures	and	power	sources.	Because	
iColor	Keypad	does	not	need	to	be	wired	to	a	power	source,	it	can	be	installed	in	a	
convenient	but	unobtrusive	location.	

Create	a	layout	plan	that	starts	with	the	location	of	the	Ethernet	switch	and,	if	
applicable,	the	PoE	injector(s),	and	includes	all	leader	cables,	CAT	5e	or	better	data	
cables,	and	fixtures.	If	using	a	PoE-compliant	Ethernet	switch,	ensure	that	a	switch	with	
an	available	port	is	installed	in	the	lighting	system.	If	using	a	non-PoE	Ethernet	switch,	
plan	to	install	the	required	PoE	injector(s)	near	the	switch.	

Assemble	additional	items:

•	 One	CAT	5e	or	better	data	cable	(unshielded	twisted	pair	with	an	RJ45	connector,	
to	a	maximum	length	of	328	ft	or	100	m)	to	connect	iColor	Keypad	to	an	available	
port	on	a	PoE-compliant	Ethernet	switch	or	to	a	PoE	injector

•	 If	using	a	PoE	injector,	an	additional	CAT	5e	or	better	cable	to	connect	the	
injector	to	the	Ethernet	switch,	and	a	power	cord	to	connect	the	injector	to	a	
power	source.	Refer	to	the	PoE	injector’s	installation	or	user	guide	for	complete	
installation	instructions.

•	 If	installing	iColor	Keypad	in	a	junction	box	in	North	America,	you	must	use	a	
UL-listed	low-voltage	junction	box	for	Class	II	equipment.	You	can	also	install	the	
keypad	in	a	multi-gang	wall	box,	or	you	can	flush-mount	it	using	the	mounting	
holes	at	the	top	and	bottom	of	the	keypad,	as	allowed	by	applicable	electrical	
codes	at	your	location.

•	 The	junction	box	included	with	iColor	Keypad	is	for	use	outside	of	North	America.	
You	will	need	the	provided	flat-head	screws	for	securing	the	keypad	housing	to	the	
junction	box.

E Refer to the iColor Keypad Installation 
Instructions for specif ic warning and caution 
statements.
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Inspect the Keypad and Accessories 
Carefully	inspect	the	box	containing	iColor	Keypad	and	the	contents	for	any	damage	
that	may	have	occurred	in	transit.	

Mount and Connect the Keypad
Make	sure	the	power	is	OFF	before	mounting	and	connecting	iColor	Keypad.

1.	 A	UL-listed	low-voltage	junction	box	for	Class	II	equipment	may	be	used	in	North	
America.	The	provided	junction	box	is	for	use	outside	of	North	America.

•	 Snap	out	a	knock-out	on	a	side	that	will	not	be	mounted	to	the	structural	
component.	

•	 Mount	the	junction	box	using	hardware	appropriate	for	the	mounting	surface,

2.	 Thread	CAT	5e	or	better	data	cable	through	the	knock-out	in	the	junction	box.

3.	 Insert	the	RJ45	connector	into	the	port	on	the	back	of	the	keypad.	When	the	
keypad	is	active,	two	indicator	lamps	indicate	Ethernet	link	(green)	and	Ethernet	
activity	(yellow).

Ethernet Controller KeypadDesigned in the USA, Made in China.

Included	in	the	box
iColor	Keypad
Software	CD
Standard	single-gang	wall	box	for	use	outside	of	
North	America

(2)	self-threading	flat	head	countersunk	M2.5	screws

Decora-style	faceplate

Installation	Instructions

OFF
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4.	 Remove	the	faceplate	from	the	keypad	by	grasping	the	top	or	bottom	edge	of	the	
faceplate	and	prying	it	gently	away	from	the	keypad.	

5.	 Align	the	screw	holes	in	the	keypad	with	the	screw	holes	in	the	wall	box.

6.	 Use	two	mounting	screws	to	attach	the	keypad	to	the	junction	box.	

7.	 Replace	the	faceplate	by	pressing	it	gently	onto	the	keypad	until	it	snaps	into	place.	

Make Cable Connections
Connect	the	CAT	5e	or	better	data	cable	to	an	available	PoE	port	on	an	Ethernet	
switch	installed	in	the	network.	

If	using	a	non-PoE	Ethernet	switch,	connect	the	CAT	5e	or	better	data	cable	to	the	
output	port	on	a	PoE	injector.	The	PoE	injector	must	be	connected	to	the	Ethernet	
switch	and	AC	outlet	in	accordance	with	the	manufacturer’s	installation	instructions.

IEEE 802.3af COMPLIANT

ETHERNET SWITCH

(PoE Port)

ETHERNET SWITCH

IEEE 802.3af

COMPLIANT

SINGLE PORT

INJECTOR

IN
OUT

Ethernet Controller KeypadDesigned in the USA, Made in China.

Ethernet Controller KeypadDesigned in the USA, Made in China.

IEEE 802.3af COMPLIANT

ETHERNET SWITCH

(PoE Port)

ETHERNET SWITCH

IEEE 802.3af

COMPLIANT

SINGLE PORT

INJECTOR

IN
OUT

Ethernet Controller KeypadDesigned in the USA, Made in China.

Ethernet Controller KeypadDesigned in the USA, Made in China.

OFF

OFF
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Using iColor Keypad
•	 Press	a	button	to	play	the	scene	associated	with	it.	By	default,	scenes	play	from	

the	beginning	at	100%	brightness.

•	 Use	the	dimmer	controls	to	adjust	the	brightness	of	the	show	lights	from	0%	–	
100%.	Press	and	hold	the	dimmer	controls	to	fade	up	or	down.

•	 Press	the	OFF	button	to	turn	all	show	lights	off.	Pressing	a	scene	button	turns	
lights	back	on	(plays	the	scene	associated	with	the	button).

iColor Keypad Maintenance
Clean	the	keypad	faceplate	and	buttons	with	a	soft,	damp	cloth.

E When playing a scene that uses the 
Variable Color effect, the dimmer controls 
adjust the effect hue, not its brightness.

Increase brightness

Turn lights offOFF
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Random Color

Custom Wash

Decrease brightness
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iColor	Keypad	buttons,	showing	factory	settings

Variable  Color
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Using iColor Keypad Effect Manager
You	use	the	iColor	Keypad	Effect	Manager	software	to	modify	the	scenes	associated	
with	the	eight	scene	buttons,	and	to	configure	the	iColor	Keypad.	For	instance,	you	
can	change	the	iColor	Keypad	IP	address,	name,	and	DMX	universe.	

Installing iColor Keypad Effect Manager Software
To	use	iColor	Keypad	Effect	Manager,	install	the	iColor	Keypad	Effect	Manager	
software	on	a	Mac	or	Windows	PC	with	the	included	CD,	then	connect	the	
computer	to	your	lighting	network.	

► To install iColor Keypad Effect Manager software:
1. Insert	the	included	CD	into	a	drive	on	a	Mac	or	Windows	computer.
2. Navigate	to	the	folder	containing	the	iColor	Keypad	Effect	Manager	installation	

files,	and	double-click	the	setup	file.
3. Follow	the	on-screen	instructions	to	install	the	iColor	Keypad	Effect	Manager	

software.

Starting iColor Keypad Effect Manager
To	use	iColor	Keypad	Effect	Manager,	iColor	Keypad	must	be	properly	installed,	
connected,	and	running.	

► To start iColor Keypad Effect Manager:
1. Do	one	of	the	following:

•	 To	start	iColor	Keypad	Effect	Manager	in	Windows,	choose	Start	>	All	
Programs	>	Philips	Color	Kinetics	>	iColor	Keypad	Effect	Manager	v1.2	>	
iColor	Keypad	Effect	Manager.

•	 To	start	iColor	Keypad	Effect	Manager	in	Mac	OS	X,	go	to	the	iColor	
Keypad	Effect	Manager	folder	in	the	Applications	folder,	and	double-click	the	
iColor	Keypad	Effect	Manager	icon.

The	iColor	Keypad	Effect	Manager	window	appears.

E To communicate with iColor Keypad, your 
computer must have a static IP address. In 
Windows, the f irst byte of your computer’s 
IP address must match the f irst byte of the 
keypad’s address (10.x.x.x., 140.x.x.x., and 
so on). In Mac OS X, you can use any IP 
address.

E You can always download the latest 
version of iColor Keypad Effect Manager 
software from www.colorkinetics.com/
support/downloads/



iColor Keypad  Product Guide 11

2. If	you	receive	the	message	“Connection	to	iColor	Keypad	timed-out,”	click	
OK.	You	can	try	to	connect	to	the	iColor	Keypad	again	by	selecting		Device	>	
Discover	Device.	
If	the	message	reappears,	or	if	the	message	“Device	communication	failure.		
IP	address	may	be	invalid”	appears	in	the	status	bar	at	the	bottom	of	the		
iColor	Keypad	Effect	Manager	window,	verify	that	iColor	Keypad	is	installed,	
connected,	and	running	properly,	and	that	your	computer’s	IP	address	is	
properly	assigned.	In	Mac	OS	X,	clear	the	router	IP	address	in	your	network	
settings.	

Modifying Scenes
A	scene	consists	of	a	built-in	effect	and	user-editable	effect	settings.	Scenes	are	
associated	with	iColor	Keypad	buttons.	Effect	settings	differ	depending	on	the	
selected	effect.	For	example,	you	can	change	the	speed	and	direction	of	the	Color	
Wash	effect,	or	the	temperature	of	the	iW	White	effect.

► To modify a scene:
1. Click	a	button	on	the	left	side	of	the	iColor	Keypad	Effect	Manager	window.	

The	currently	selected	button	displays	a	green	dot,	and	the	currently	associated	
effect	and	its	settings	appear	in	the	Settings	panel,	on	the	right	side	of	the	
window.

2. Click	the	System	Configuration	tab	in	the	Settings	panel,	and	select	the	type	of	
fixture	that	you’re	using	in	your	installation	from	the	Fixture	drop-down	list.

3. Click	the	Scene	Settings	tab	in	the	Settings	panel.
4. To	change	the	effect	associated	with	the	selected	scene,	select	a	different	effect	

from	the	Effect	drop-down	list.
5. Change	the	effect	settings	as	desired,	as	described	in	“Modifying	Effects”	below.
6. Click	Save.

Modifying Effects
Follow	steps	1	–	4	in	“Modifying	Scenes”	above,	then	follow	the	steps	for	the	effect	
you	want	to	modify	below.	Changes	are	stored	on	iColor	Keypad.	If	you	modify	the	
effect	associated	with	the	scene	currently	displayed	on	connected	lights,	the	changes	
are	immediately	displayed.

► To modify the Fixed Color effect:
1. Select	a	color	using	the	Color	Picker’s	RGB	Range	or	White	Range,	as	described	

on	pages	15	–	17.
2. Click	Save.	

► To modify the Variable Color effect:
1. Select	a	color	using	the	Color	Picker’s	RGB	Range,	as	described	on	pages		

15	–	17.	
2. Click	Save.	

► To modify the Color Wash effect:
1. Using	the	Speed	slider,	set	effect	transition	time,	from	5	seconds	to	10	minutes.	
2. Set	how	the	direction	in	which	the	effect	appears	to	move	by	clicking	Left	to	

Right	or	Right	to	Left.
3. Click	Save.	

iColor Keypad Effects

Fixed	Color

Variable	Color

iW	White

Random	Color

RGB	White

Custom	Wash

Rainbow	Wash

Color	Wash

E If the Settings panel is not visible, select 
View > Settings.

E When connected to your lighting 
network, the Up, Down, and Off buttons in 
iColor Keypad Effect Manager behave exactly 
like the Up, Down, and Off buttons on the 
iColor Keypad.

E For details on selecting f ixture types, 
refer to “Selecting Fixture Type” on page 19.

E To revert to the previously saved version 
of a scene, click Undo.

E Do not use the Color Picker’s White 
Range with the Variable Color effect.
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iColor Keypad Effects and Their Settings

Fixed Color  Displays	a	single	color	on	all	fixtures.	iColor	Keypad		
Up	and	Down	buttons	adjust	scene	brightness.

Color	 Select	an	effect	color	using	the	RGB	Range	or	the	White	Range

Variable Color  Displays	a	single	color	on	all	fixtures.	iColor	Keypad	
Up	and	Down	buttons	adjust	RGB	value.

Color	 Select	an	effect	color	using	the	RGB	Range

Color Wash  Produces	a	smooth	hue	transition	on	all	fixtures	
simultaneously,	progressing	through	the	color	spectrum.

Speed	 Set	effect	transition	time,	from	5	seconds	to	10	minutes
Direction	 Set	how	effect	appears	to	move:	Left	To	Right	or	Right	To	Left

Rainbow Wash  Produces	a	smooth	transition	through	the	color	
spectrum.	Colors	appear	to	follow	each	other	from	fixture	to	fixture.

Speed	 Set	effect	transition	time,	from	5	seconds	to	10	minutes
Width	 Set	the	width	of	the	rainbow,	from	4	–	35	nodes	
Direction	 Set	how	effect	appears	to	move:	Left	To	Right	or	Right	To	Left

Custom Wash  Produces	a	marching	color	transition	across	all	
fixtures,	progressing	through	two	to	six	selected	colors.	

Color Bar	 Add	or	delete	effect	colors,	from	2	to	6
Color	 Set	each	effect	color	using	the	RGB	Range	or	the	White	Range
Speed	 Set	effect	transition	time,	from	1	second	to	10	minutes
Width	 Set	the	width	of	each	of	block	of	color,	from	1	–	32	nodes	
Direction	 Set	how	effect	appears	to	move:	Left	To	Right	or	Right	To	Left

Random Color  Displays	a	sequence	of	random	colors	on	all	
fixtures,	either	fading	or	snapping	from	color	to	color.

Speed	 Set	effect	transition	time,	from	1	second	to	10	minutes
Fade	 Determine	whether	color	transitions	fade	or	snap

RGB White  Displays	RGB	white	light	on	all	fixtures,	with	user-
specified	color	temperature.	For	color-changing	LED	fixtures.

Temperature	 Select	cooler	or	warmer	white	light
Intensity Set	the	programmed	brightness	of	the	scene,	from	0%	to	100%

iW White  Displays	white	light	on	all	fixtures,	with	user-specified	
color	temperature.	For	two-channel	intelligent	white	(iW)	fixtures.

Temperature	 Select	cooler	or	warmer	white	light
Intensity Set	the	programmed	brightness	of	the	scene,	from	0%	to	100%
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► To modify the Rainbow Wash effect:
1. Using	the	Speed	slider,	set	effect	transition	time,	from	5	seconds	to	10	minutes.	
2. Using	the	Width	controls,	set	the	width	of	the	rainbow,	from	4	–	35	nodes.
3. Set	how	the	direction	in	which	the	effect	appears	to	move	by	clicking	Left	to	

Right	or	Right	to	Left.
4. Click	Save.	

► To modify the Custom Wash effect:
1. Using	the	color	bar,	set	the	effect	colors:

	▪ To	add	a	color	to	the	Custom	Wash	effect,	click	the	+	icon	at	the	right	of	the	
color	bar	(maximum	of	six	colors).

	▪ To	delete	a	color	from	effect,	right-click	a	color	swatch	in	the	color	bar	and	
select	Delete	Color	from	the	pop-up	menu	(minimum	of	two	colors).

	▪ To	modify	an	effect	color,	select	the	color	in	the	color	bar	and	use	the	RGB	
Range	or	White	Range,	as	described	on	pages	15	–	17.

2. Using	the	Speed	slider,	set	the	effect	transition	time,	from	1	second	to	10	
minutes.

3. Using	the	Width	controls,	set	the	width	of	each	of	block	of	color,	from	1	–	32	
nodes.

4. Set	how	the	direction	in	which	the	effect	appears	to	move	by	clicking	Left	to	
Right	or	Right	to	Left.

5. Click	Save.	

► To modify the Random Color effect:
1. Using	the	Speed	slider,	set	effect	transition	time,	from	1	seconds	to	10	minutes.	
2. Check	Fade	to	make	color	transitions	fade.	Uncheck	Fade	to	make	color	

transitions	snap.
3. Click	Save.	

Color	Bar
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► To modify the RGB White effect:
1. Using	the	Temperature	slider,	select	cooler	or	warmer	white	light.
2. Using	the	Intensity	controls,	set	the	programmed	brightness	of	the	scene,	from	

0%	to	100%.
3. Click	Save.	

► To modify the iW White effect:
1. Using	the	Temperature	slider,	select	cooler	or	warmer	white	light.
2. Using	the	Intensity	controls,	set	the	programmed	brightness	of	the	scene,	from	

0%	to	100%.
3. Click	Save.

Notes on Fixture Configuration
iColor	Keypad	broadcasts	three	channels	of	DMX	data	to	connected	
fixtures.	To	use	iColor	Keypad	with	fixture	types	other	than	standard	
three-channel	RGB,	you	must	make	sure	that	the	fixtures	are	configured	
appropriately.	You	typically	perform	fixture	configuration	with	
QuickPlay	Pro	addressing	and	configuration	software,	or	with	a	fixture’s	
on-board	controls.	Refer	to	specific	fixture	Product	Guides	for	details.

Make	sure	that	you	also	select	the	correct	fixture	type	on	the	System	
Configuration	tab	in	iColor	Keypad	Effect	Manager	before	selecting	
shades	of	white	and	tinted	whites	with	the	White	Range.	The	
calculations	that	iColor	Keypad	Effect	Manager	performs	to	arrive	at	
DMX	values	for	these	colors	differ	depending	on	fixture	type.	If	you	
change	the	fixture	type,	you	must	re-define	and	re-save	any	scenes	that	
use	effects	with	colors	selected	with	the	White	Range.

Configuring Color-Changing Fixtures with More than Three 
Channels	
For	reliable	results,	you	must	configure	four-channel,	five-channel,	and	
IntelliHue	fixtures	to	work	in	three-to-n-channel	mode.	For	instance,	
you	must	configure	ColorBlast	TRX	to	work	in	RGB	>	RGBAW	mode.	

Configuring Two- and Three-Channel iW Fixtures	
Two-channel	iW	fixtures,	such	as	iW	Burst	Powercore	and	iW	Burst	
Compact	Powercore,	use	one	channel	of	warm	white	LEDs	and	one	
channel	of	cool	white	LEDs	to	produce	a	range	of	color	temperatures.	
Three-channel	iW	fixtures,	such	as	iW	Cove	MX	Powercore	and		
iW	Graze	MX	Powercore,	add	a	channel	of	neutral	white	LEDs	for	
greater	precision	in	color	temperature	and	color	mixing.

For	compatibility	with	two-channel	iW	fixtures,	most	three-channel	iW	
fixtures	can	be	configured	to	accept	two	channels	of	data	input.	When	
an	iW	fixture	is	in	two-channel	mode,	you	can	use	the	IW	White	effect	
to	adjust	the	fixture’s	color	temperature	(relative	warmth	or	coolness)	
and	intensity.	The	two	channels	of	data	input	are	automatically	mapped	
to	the	fixture’s	three	LED	channels.

If	iW	fixtures	are	in	three-channel	mode,	you	can	use	the	color	picker’s	
RGB	Range	to	select	colors	for	effects.	In	three-channel	mode,	the	
warm	channel	maps	to	Red,	the	neutral	channel	to	Green,	and	the	cool	
channel	to	Blue.

E For details on selecting f ixture types, 
refer to “Selecting Fixture Type” on page 19.

E You can download QuickPlay Pro from 
www.philipscolorkinetics.com/support/
addressing/
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Using the Color Picker
The	Fixed	Color,	Variable	Color,	and	Custom	Wash	effects	feature	a	color	picker	with	
which	you	can	select	specific	colors	of	light	for	color-changing	fixtures	of	three	or	
more	channels.	The	color	picker	offers	an	RGB	Range	for	picking	colors,	and	a	White	
Range	for	targeting	or	shades	or	tints	of	white	light.

Switching Between the RGB Range and the White Range	
You	can	switch	between	the	RGB	Range	and	the	White	Range	using	the	Display	RGB	
Range	and	Display	White	Range	buttons.	You	can	also	switch	between	the	ranges	by	
clicking	items	in	the	Favorites	list.	RGB	colors	display	the	RGB	Range,	while	shades	of	
white	or	tinted	whites	display	the	White	Range.

Selecting Colors with the RGB Range	
The	RGB	Range	lets	you	select	a	specific	color	using	the	Color	Spectrum,	Color	
Detail,	and	Color	Field	controls,	or	using	the	sliders	for	the	RGB	(red	/	green	/	blue)	
color	model	or	the	HSV	(hue	/	saturation	/	brightness)	color	model.

The	currently	selected	color	appears	in	the	active	swatch	box.	The	currently	selected	
color	is	also	indicated	on	the	Color	Spectrum	and	the	Color	Field	by	a	color	point	(a	
white	dot),	and	on	the	Color	Detail	control	by	a	highlighted	box.	You	can	change	the	
currently	selected	color	by	dragging	the	white	dot	to	a	new	location	on	any	of	the	
color	controls,	or	by	using	the	RGB	and	HSV	sliders,	in	any	combination.	If	lights	are	
connected	to	your	system	and	are	turned	on,	they	display	the	active	swatch	color.

To	make	it	easier	to	select	and	fine-tune	specific	colors,	the	Color	Detail	control	
displays	colors	adjacent	to	the	currently	selected	color.	You	can	adjust	the	range	of	
colors	displayed	in	the	Color	Detail	control	by	using	the	Color	Detail	Zoom	slider.	
Like	on	a	map,	zooming	in	enlarges	the	area	immediately	adjacent	to	the	color	point.	
When	you	zoom	in	and	out,	the	white	bounding	box	on	the	Color	Spectrum	shrinks	
or	expands	to	indicate	the	region	displayed	in	the	Color	Detail	control.	The	more	you	
zoom	in,	the	less	difference	between	adjacent	colors	in	the	Color	Detail	control.	

Zoomed	out Zoomed	in

Less	difference	
between	adjacent	

colors

More	difference	
between	adjacent	

colors

Color	Picker:	RGB	Range Color	Picker:	White	Range

Display	RGB	Range Display	White	Range

Color	Spectrum
Color	Detail

Color	Field

Color	Detail	Zoom

Favorites

Chromaticity	Diagram

Active	Swatch

Comparison	Swatches

Tint	Slider
CCT	Slider

1 2 3
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Selecting a Shade of White with the White Range	
The	White	Range	targets	an	area	within	the	CIE	1931	x-y	chromaticity	space,	on	
which	correlated	color	temperatures	(CCTs)	for	white	light	are	defined.	To	make	
it	easier	to	select	shades	of	white	light	and	tinted	white	light,	the	White	Range	
constrains	color	selections	to	an	area	along	the	black-body	curve	and	the	iso	lines	that	
extend	above	and	below	it.	To	select	colors	outside	of	this	area,	use	the	RGB	Range.	

The	White	Range	lets	you	select	a	specific	shade	or	tint	of	white	using	the	
Chromaticity	Diagram	and	the	Tint	and	CCT	sliders.	The	currently	selected	shade	of	
white	appears	in	the	active	swatch.	The	currently	selected	shade	is	also	indicated	on	
the	Chromaticity	Diagram	by	a	color	point	(a	white	dot),	and	by	positions	on	the	Tint	
and	CCT	sliders.	You	can	change	the	currently	selected	shade	by	dragging	the	white	
dot	to	a	new	location	on	the	Chromaticity	Diagram,	or	by	using	the	Tint	and	CCT	
sliders,	in	any	combination.	The	CCT	slider	moves	the	color	point	along	the	black-
body	curve,	while	the	Tint	slider	moves	the	color	point	perpendicular	to	the	black-
body	curve,	parallel	with	the	iso	lines.	If	lights	are	connected	to	your	system	and	are	
turned	on,	they	display	the	active	swatch	color.

Keep	in	mind	that	the	color	point	and	the	slider	positions	make	a	general	indication	
of	CCT	and	tint,	and	do	not	imply	or	guarantee	color	accuracy	or	color	consistency	
across	different	fixture	types.	Think	of	the	color	point	and	slider	positions	as	good	
starting	points.	If	targeting	an	exact	color	temperature	or	x-y	coordinate	is	critical,	
be	sure	to	use	a	light	meter	or	other	measurement	device	to	test	the	output	of	your	
lighting	fixtures.

Color	definitions	created	with	the	White	Range	differ	depending	on	fixture	type.	To	
re-use	shades	of	white	and	tinted	whites	with	different	fixture	types,	make	sure	you	
save	them	to	the	Favorites	list.	You	can	then	re-load	the	colors	and	re-save	the	effects	
when	you	change	fixture	types.

Using the Active and Comparison Swatches	
Both	the	RGB	Range	and	the	White	Range	offer	active	and	comparison	swatches	to	
make	it	easier	to	compare	and	select	colors.	

The	currently	selected	color	appears	in	the	active	swatch.	You	can	also	load	colors	
into	the	active	swatch	by	clicking	an	item	in	the	Favorites	list.	You	can	load	colors	into	
the	comparison	swatches	by	dragging	and	dropping	them	from	the	active	swatch	in	
either	view,	or	from	the	Color	Detail	control	in	the	RGB	Range	view.	

When	you	save	settings	for	the	Fixed	Color	or	Variable	Color	effect,	or	when	you	
add	a	color	to	the	Custom	Wash	effect,	iColor	Keypad	Effect	Manager	uses	the	color	
currently	loaded	in	the	active	swatch.

The	White	Range	constrains	
selections	to	an	area	along	the	
black-body	curve	and	the	iso	
lines	above	and	below	it

For	colors	outside	the	White	
Range,	use	the	RGB	Range

Active	Swatch

Comparison	Swatches

E For details on selecting f ixture type, refer 
to “Selecting Fixture types” on page 19..

E The White Range helps you target 
shades and tints of white light using color-
changing f ixtures of three or more channels. 
Use the iW White effect for selecting color 
temperatures with IntelliWhite f ixtures 
in 2-channel mode. You can also use the 
RGB Range with IntelliWhite f ixtures 
in 3-channel mode. Refer to “Notes on 
Fixture Configuration” on page 14 for more 
information.

1 2 3

E Do not use the Color Picker’s White 
Range with the Variable Color effect.
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Saving and Undoing Changes to Scenes
When	you	make	changes	to	scene	colors	using	the	color	picker,	iColor	Keypad	Effect	
Manager	shows	the	changes	but	does	not	store	them	on	iColor	Keypad	until	you	save	
them.	

•	 To	save	scene	changes	and	store	them	on	the	iColor	Keypad.	click	Save.	

•	 To	revert	to	the	previously	saved	version	of	the	scene,	click	Undo.

Using and Creating Favorites	
By	default,	iColor	Keypad	Effect	Manager	offers	a	list	of	Favorites	that	includes	12	
RGB	colors	and	20	shades	or	tints	of	white.	

•	 Clicking	an	RGB	color	in	the	Favorites	list	displays	the	RGB	Range	and	loads	the	
color	into	the	active	swatch.	

•	 Clicking	a	shade	of	white	in	the	Favorites	list	displays	the	White	Range	and	loads	
the	color	into	the	active	swatch.

•	 To	create	a	new	Favorite,	select	a	color	and	click	the	Add	to	Favorites	button.	
The	new	Favorite	appears	with	a	default	name	(Color1,	Color2,	and	so	on)	in	the	
Favorites	list.

•	 To	rename	a	Favorite,	double-click	the	name	and	enter	a	new	name.

•	 To	delete	a	Favorite,	select	the	Favorite	and	press	Delete.	

Add	to	Favorites	button

Rename	a	Favorite	
by	double-clicking	its	
name	and	entering	a	

new	name

Color Picker Keyboard Shortcuts
Action Shortcut

Zoom	in	and	out	on	the	Color	Spectrum	 Ctrl	-	+	/	Ctrl	-	–

Move	the	color	point	on	the	Color	Spectrum,	Color	Detail,	
Color	Field,	or	Chromaticity	Diagram 	/		/		/	

Increase	/	decrease	zoom	on	the	Color	Detail	Zoom	slider 	/	

Increase	/	decrease	red	on	the	Chromaticity	Diagram Ctrl	-	r	/	Ctrl	-	Shift	-	r

Increase	/	decrease	green	on	the	Chromaticity	Diagram Ctrl	-	g	/	Ctrl	-	Shift	-	g

Increase	/	decrease	blue	on	the	Chromaticity	Diagram Ctrl	-	b	/	Ctrl	-	Shift	-	b

Increase	/	decrease	CCT	on	the	CCT	slider 	/	

Move	up	and	down	the	Tint	Slider 	/	

Switch	between	controls	without	moving	the	color	point Ctrl	-	click	or	Right	-	click

Copy	Comparison	Swatch	1	color	to	the	Active	Swatch Ctrl	-	1

Copy	Comparison	Swatch	2	color	to	the	Active	Swatch Ctrl	-	2

Copy	Comparison	Swatch	3	color	to	the	Active	Swatch Ctrl	-	3
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Changing System Configuration
The	System	Configuration	tab	on	the	Settings	panel	lets	you	change	iColor	Keypad	
name	and	IP	address,	set	universe,	KiNET	mode,	the	number	of	lights	per	port,	the	
number	of	ports,	the	fixture	type	for	defining	shades	of	white,	and	which	keypad	
buttons	are	enabled.

Changing the Keypad Name
You	can	change	the	name	of	an	iColor	Keypad	to	uniquely	identify	it.	By	default,	each	
keypad	is	named	“iColor	Keypad.”

► To change the name of iColor Keypad:
1. Click	the	System	Configuration	tab	on	the	Settings	panel.	
2. Enter	a	new	name	in	the	Name	text	box.
3. Click	Save.	

Changing the Keypad IP Address
Each	iColor	Keypad	comes	factory-set	with	a	unique	IP	address.	For	convenience,	you	
can	change	a	keypad’s	IP	address.

► To change the IP address of iColor Keypad:
1. Click	the	System	Configuration	tab	on	the	Settings	panel.	
2. Enter	a	new	IP	address	in	the	Address	text	box.
3. Click	Save.	

E In Windows, make sure that the f irst 
byte of your computer’s IP address matches 
the f irst byte of the keypad’s address 
(10.x.x.x., 140.x.x.x., and so on). 



iColor Keypad  Product Guide 19

Setting the DMX Universe
By	default,	iColor	Keypad	is	set	to	control	DMX	universe	0	(zero).	All	Philips	Color	
Kinetics	power	/	data	supplies	also	come	factory-set	to	DMX	universe	0.	If	the	DMX	
universe	of	a	connected	power	/	data	supply	has	been	changed	—	for	example,	in	
a	complex	installation	spanning	multiple	DMX	universes	—	you	must	change	the	
Universe	setting	in	iColor	Keypad	to	match	it.

► To set the DMX universe that iColor Keypad controls:
1. Click	the	System	Configuration	tab	on	the	Settings	panel.	
2. Enter	a	new	universe	number	(0	–	255)	in	the	Universe	box,	or	use	the	Up	and	

Down	arrows	to	select	a	new	universe	number.
3. Click	Save.	

Setting the KiNET Mode
KiNET	is	a	high-performance	Ethernet	protocol	engineered	by	Philips	Color	Kinetics	
for	LED	lighting	control.	Most	Philips	Color	Kinetics	devices	can	use	KiNET	version	
1	(the	default	in	iColor	Keypad).	However,	sPDS-480ca	power	/	data	supplies	require	
KiNET	version	2.		

► To set KiNET mode:
1. Click	the	System	Configuration	tab	on	the	Settings	panel.		
2. Enter	1	or	2	in	the	KiNET	Mode	box.
3. Click	Save.	

Setting the Number of Lights Per Power / Data Supply Port
For	KiNET	version	1,	the	Lights	per	Port	setting	in	iColor	Keypad	should	equal	or	
exceed	the	number	of	sequentially	addressed	nodes	connected	to	the	power	/	data	
supply.	By	default,	iColor	Keypad	is	set	to	72	nodes	per	power	/	data	supply	port,	
which	is	sufficient	for	most	installations.

For	KiNET	version	2	(Data	Enabler	Pro	or	sPDS-480ca),	set	the	lights	per	port	to	
equal	the	maximum	number	of	nodes	connected	to	a	power	/	data	supply	port.

► To set the number of lights per power / data supply:
1. Click	the	System	Configuration	tab	on	the	Settings	panel.
2. Enter	a	new	number	(1	–	170)	in	the	Lights	per	Port	box,	or	use	the	Up	and	

Down	arrows	to	select	a	new	number.
3. Click	Save.	

Setting the Number of Power / Data Supply Ports
For	KiNET	version	2	only,	the	Number	of	Ports	setting	in	iColor	Keypad	should	equal	
the	number	of	power	/	data	supply	ports	with	connected	lights.	(To	ensure	optimal	
operation,	lights	should	be	connected	to	power	/	data	supply	ports	in	sequence,	
starting	with	port	1	—	ports	1	through	5	on	an	sPDS-480ca,	for	example.)	

► To set the number of power / data supply ports:
1. Click	the	System	Configuration	tab	on	the	Settings	panel.	
2. Enter	a	new	number	(1	–	16)	in	the	Number	of	Ports	box,	or	use	the	Up	and	

Down	arrows	to	select	a	new	number.
3. Click	Save.	
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Selecting Fixture Type
For	reliable	results,	you	must	select	the	type	of	fixture	you’re	using	in	your	installation	
before	selecting	and	saving	shades	of	white	and	tinted	whites	with	the	White	Range	
in	the	Color	Picker.	The	calculations	that	iColor	Keypad	Effect	Manager	performs	to	
arrive	at	DMX	values	for	colors	in	the	White	Range	differ	depending	on	the	number	
and	type	of	LED	channels	in	the	fixtures	you’re	using.	If	you	change	fixture	type,	you	
must	re-define	and	re-save	any	scenes	that	use	effects	with	colors	selected	with	the	
White	Range.

Note	that	iColor	Keypad	does	not	support	lighting	installations	with	a	mixture	of	
different	fixture	types.	We	recommend	using	iColor	Player	or	iPlayer	3	for	reliable	
control	of	lighting	installations	with	multiple	fixture	types.

► To select fixture type:
1. Click	the	System	Configuration	tab	on	the	Settings	panel.	
2. Select	your	fixture	type	from	the	Fixture	drop-down	list:

	▪ Select	Generic	RGB	when	using	three-channel	fixtures	such	as	ColorBlast	
Powercore,	ColorReach	Powercore,	iColor	Cove	MX	Powercore,	and	iW	
Fuse	Powercore	(in	three-channel	mode).

	▪ Select	Blaze	/	Blast	TRX	when	using	ColorBlaze	TRX	or	ColorBlast	TRX	
5-channel	fixtures.	

	▪ Select	SkyRibbon	when	using	color-changing	SkyRibbon	fixtures.	
3. Click	Save.	

Enabling and Disabling Keypad Buttons
By	default,	all	iColor	Keypad	buttons	are	enabled.	To	limit	access	to	keypad	functions,	
you	can	disable	any	of	the	eight	Scene	buttons,	the	Down	and	Up	buttons	for	adjusting	
fixture	brightness,	or	the	On/Off	button.

► To enable or disable keypad buttons:
1. Click	the	System	Configuration	tab	on	the	Settings	panel.	
2. To	enable	a	button,	check	the	box	next	to	the	button	name.	To	disable	a	button,	

uncheck	the	box	next	to	the	button	name.
3. Click	Save.	

Selecting a Network
If	your	computer	has	multiple	network	interface	cards	(NIC	cards)	to	manage	multiple	
networks,	you	can	select	the	network	on	which	you	want	to	run	your	lighting	system.	

► To select a network:
1. Click	the	System	Configuration	tab	on	the	Settings	panel.
2. Do	one	of	the	following:

	▪ Click	“Use	default	interface”	to	let	your	computer	decide	which	NIC	card	to	
use.

	▪ Click	“Use	selected,”	then	select	a	network	from	the	list.	

E You must also make sure that your 
f ixtures are configured properly. Refer to 
“Notes on Fixture Configuration” on page 14 
for more information.

E To re-use shades of white and tinted 
whites with different f ixture types, make sure 
you save your colors to the Favorites list. You 
can then re-load the colors and re-save the 
effects to work with the new fixture type.
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Restoring Factory Default Settings
You	may	want	to	restore	the	factory	default	settings	for	iColor	Keypad.	Except	for	IP	
address	and	iColor	Keypad	name,	all	saved	changes	to	scenes	and	system	settings	are	
overwritten	with	the	default	settings.	

► To restore the factory default settings:
1. Select	Device	>	Restore	Factory	Defaults.	
2. Click	Yes	to	continue	and	restore	default	settings.	

Saving and Loading Configuration Files
A	configuration	file	(.xml	format)	contains	all	scene	settings	and	all	configuration	
information	except	for	iColor	Keypad	name	and	IP	address.	You	can	save	custom	
settings	in	a	configuration	file,	then	use	the	file	to	program	multiple	devices.		

► To save and load a configuration file:
1. Select	File	>	Save	Configuration	File	to	save	a	keypad’s	current	settings.	Give	the	

configuration	file	a	name	and	location,	and	click	OK.	
2. Select	File	>	Load	Configuration	File	to	load	saved	keypad	settings.	Navigate	to	a	

location	containing	a	valid	configuration	file,	select	the	file,	and	click	Open.	

Updating iColor Keypad Effect Manager Software
iColor	Keypad	Effect	Manager	software	is	periodically	updated	with	new	features.	
You	can	check	for	updates	whenever	you	like,	or	you	can	set	iColor	Keypad	Effect	
Manager	to	automatically	notify	you	of	available	updates.

► To update iColor Keypad Effect Manager software:
1. Select	Help	>	Update.
2. To	check	for	updates	now,	click	Check	Now.
3. To	automatically	check	for	updates,	check	“Automatically	check	for	updates.”	

Enter	the	frequency	you	want	to	check	for	updates,	in	days.	If	you	use	a	proxy	
server	to	connect	to	the	Internet,	check	“Use	a	proxy	to	access	the	internet,”	
then	enter	the	proxy	information.

4. Click	OK.	

Updating iColor Keypad Firmware
iColor	Keypad	firmware	is	periodically	updated	to	improve	device	performance		
and	functionality.	To	maximize	system	performance,	make	sure	your	iColor	Keypad	
devices	are	running	the	most	recent	version	of	the	firmware.	

Download iColor Keypad Firmware 
If	a	more	recent	version	of	the	iColor	Keypad	firmware	is	available,	download	the	
firmware	file	(.hex	extension):

1.	 Visit	the	Firmware	Updates	page	at	www.colorkinetics.com/support/downloads/
firmware/	to	check	for	the	latest	firmware	version.	

2.	 If	a	newer	firmware	image	is	available,	click	the	link	on	the	Firmware	Updates	page	
to	download	the	firmware	file	to	an	accessible	location	on	your	computer.

E You can check the version number of the 
software currently installed on iColor Keypad 
on the System Configuration tab in the 
Settings panel within iColor Keypad Effect 
Manager.

E You can also restore the factory default 
settings, including the factory-set IP address, 
using the iColor Keypad buttons (iColor 
Keypad name is not reset). Press the top two 
buttons for three seconds. After the indicator 
lights f lash, press the OFF button within f ive 
seconds until all indicator lights are off.

E You can check for and download new 
versions of iColor Keypad Effect Manager 
software at any time by visiting www.
colorkinetics.com/support/downloads/

E When loading a configuration file, 
brightness is automatically set to 100%. 
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Download CK Firmware Updater
To	update	the	firmware	image	on	a	iColor	Keypad	device,	you	must	download	and	
install	the	CK	Firmware	Updater	application	on	your	computer.

1.	 Visit	the	Firmware	Updates	page	at	www.colorkinetics.com/support/downloads/
firmware/

2.	 Download	the	Firmware	Updater	Utility.

3.	 Decompress	the	file	to	an	accessible	location	on	your	computer	and	open	it.

4.	 Run	the	installer,	and	follow	the	on-screen	instructions.	

Running an iColor Keypad Firmware Update
You	can	update	iColor	Keypad	firmware	using	a	computer	running	CK	Firmware	
Updater	software.	

1.	 Connect	a	computer	to	your	lighting	network	using	a	standard	Ethernet	cable.

2.	 Run	CK	Firmware	Updater.

3.	 From	the	Interface	Select	drop-down	list,	select	Ethernet	Controllers.

4.	 From	Device	Select	drop-down	list,	select	iColor	Keypad.

5.	 Click	File	Select,	navigate	to	the	folder	to	which	you	downloaded	the	firmware	file	
(.hex	extension),	and	click	Open.	

6.	 Click	Discover.	CK	Firmware	Updater	discovers	the	iColor	Keypad	devices	
installed	in	the	lighting	network.	

7.	 Select	the	iColor	Keypad	device	you	want	to	update.

8.	 Click	PROGRAM.

9.	 Repeat	steps	7	and	8	for	each	iColor	Keypad	device	you	want	to	update.
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